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Wat is nieuw
Wat is nieuw in TI Connect™ CE-software v5.4.0
Quit Onderzoekmodus instelling op aangesloten CE rekenmachines

Sluit de examenstand af op uw CE door de CE-rekenmachine(s) op de computer aan te
sluiten en de opties

• Acties > Toets-modus afsluiten op aangesloten CE rekenmachines in TI CONNECT™
CE.

Onthoud: Gebruik de meest recente CE-bundel op education.ti.com/84ceupdate om
ervoor te zorgen dat uw CE de meest recente en geschikte rekenmachinebestanden
voor uw TI-84 Plus CE heeft.

Voor meer informatie over de nieuwe en geüpdatete functionaliteit, ga naar
education.ti.com/84ceupdate.

Wat is nieuw 1

https://education.ti.com/84ceupdate
https://education.ti.com/84ceupdate


2 Inleiding op de TI Connect™ CE-software

Inleiding op de TI Connect™ CE-software
De TI Connect™ CE-software maakt het uitwisselen van informatie tussen uw grafische
rekenmachine en uw computer snel en makkelijk.

De software ondersteunt alle grafische rekenmachines van de TI-8x-serie met een
USB-poort, waaronder:

• TI-84 Plus CE

• TI-84 Plus CE-T

• TI 84 Plus C Silver Edition

• TI-84 Plus

• TI-84 Plus T

• TI-83 Premium CE

• TI-83 Plus.fr

• TI-82 Advanced

Opmerking: Gebruik TI Connect 4.0 software die rekenmachines ondersteunt die alleen
over een I/O-poort beschikken:

• TI-83 Plus

• TI-89 Titanium

• Voyage 200

• TI-73 Explorer



Met behulp van de TI Connect ™ CE Software
Het van de TI Connect™ CE-software bevat tools die u kunt gebruiken om informatie uit
te wisselen tussen uw rekenmachine en uw computer.

De TI Connect™ CE-software bevat drie werkruimtes:

• Screen Capture (Schermvastlegging): hiermee kunt u schermvastleggingen beheren

• Calculator Explorer (Rekenmachineverkenner): hiermee kunt u inhoud van
rekenmachines beheren

• Program Editor (Programmabewerker): hiermee kunt u TI basisprogramma's te
beheren

Met behulp van de TI Connect ™ CE Software 3



4 Met behulp van de TI Connect ™ CE Software

Delen van de TI Connect ™ CE Software

Menubalk - Gebruik deze menu's om rekenmachinebestanden en -schermen
te beheren, informatie over de rekenmachine te bekijken en om hulp te
krijgen.

Werkbalk - Gebruik deze pictogrammen om computerbestanden en -schermen
te beheren.

Werkruimtepaneel - Gebruik dit paneel om werkruimtes te selecteren
(Calculator Explorer, Screen Capture en Program Editor).

Paneel Lijst met rekenmachines - Gebruik deze lijst om alle aangesloten
rekenmachines te bekijken en om één rekenmachine te selecteren voor
weergave.



Inhoudspaneel - Gebruik dit paneel om de rekenmachinebestanden en -
schermen op aangesloten rekenmachine(s) te bekijken en te beheren.

Opmerking: u kunt de meeste van de acties in deze menu's uitvoeren door
items te verslepen en neer te zetten op uw aangesloten rekenmachine of
computer.

Met behulp van de TI Connect ™ CE Software 5



6 De werkruimte Screen Capture gebruiken

De werkruimte Screen Capture gebruiken
Met de werkruimte Screen Capture kunt u schermvastleggingen van rekenmachines
beheren.



Delen van de Screen Capture Workspace
Menubalk - Gebruik deze menu's om bestanden en afbeeldingen te beheren,
informatie over de rekenmachine te bekijken en om hulp te krijgen.

Opmerking: u kunt de meeste van de acties in deze menu's uitvoeren door items
van het Inhoudspaneel te verslepen en neer te zetten.

Werkbalk - Klik op deze pictogrammen om bestanden op te slaan, te verzenden, te
kopiëren, te verwijderen en de afmetingen ervan te veranderen.

Een bestand op de computer opslaan.

Een bestand verzenden naar een rekenmachine.

Een bestand kopiëren.

Een bestand wissen.

Een rand toevoegen aan of verwijderen van alle vastgelegde schermen.

De afmetingen van alle vastgelegde schermen veranderen.

De afmetingen van de schermvastlegging bekijken.

Inhoudspaneel - Schermvastleggingen bekijken in het Inhoudspaneel.

Schermen vastleggen en gebruiken
In de werkruimte Screen Capture kunt u schermen van uw rekenmachine vastleggen en
bekijken.

De werkruimte Screen Capture gebruiken 7



8 De werkruimte Screen Capture gebruiken

Voordat u begint

Sluit de rekenmachine aan op de computer en zorg ervoor dat verschijnt in de
Calculator List Panel.

Rekenmachineschermen vastleggen

1. Klik op het TI Connect™ paneel Werkruimte van de CE-software op de werkruimte
Screen Capture.

2. Geef het scherm weer op uw rekenmachine dat u wilt vastleggen.

3. Klik op naast de gewenste rekenmachine in het paneel met de lijst met
rekenmachines.

• Als er meer dan één rekenmachine is aangesloten, klik dan op naast
CONNECTED CALCULATORS om schermen van alle rekenmachines vast te leggen.

Rekenmachineschermen opslaan als bestanden
Met de werkruimte Screen Capture kunt u vastgelegde of bestaande afbeeldingen van
uw rekenmachine opslaan als PNG-bestanden.

Opmerking: het sterretje aan het begin van de naam van een afbeelding geeft aan dat
de afbeelding niet is opgeslagen.

Een bestaand scherm opslaan

1. Klik op het vastgelegde scherm in het paneel Content (Inhoud).

2. Klik op .
Meerdere schermen opslaan

1. Klik op Edit > Select All (Bewerken > Alles selecteren).

2. Klik op .
Een schermvastlegging een andere naam geven

1. Plaats de cursor aan het begin van het veld met de schermnaam.
Bv.: Capture 1.

2. Dubbelklik op de naam om deze te selecteren.

3. Typ een nieuwe naam in voor het computerbestand.



Een nieuwe schermvastlegging opslaan als PNG-bestand

1. Klik op de afbeelding.

2. Klik op .
3. Navigeer naar de gewenste locatie voor opslag.

4. Gebruik de standaard bestandsnaam of typ een nieuwe bestandsnaam in.

5. Klik op .

Schermvastleggingen naar aangesloten rekenmachines verzenden

De functie Screen Capture Only biedt een manier om een scherm met een grafiek op
rekenmachines met een hoge resolutie vast te leggen, het grafiekgebied bij te snijden
en vervolgens alleen het grafiekgebied te converteren naar een achtergrondafbeelding.
Vink Graph Area Only (Alleen grafiekgebied) aan om dit type achtergrondafbeelding te
creëren.

1. Leg het scherm vast als u dit nog niet gedaan heeft.

2. Klik op de schermvastlegging om deze te selecteren.

3. Klik op

• FILE NAME (BESTANDSNAAM): Deze kan anders zijn dan de NAME ON
CALCULATOR (NAAM OP REKENMACHINE), afhankelijk van welke naam u de
schermvastlegging heeft gegeven op uw computer.

• NAME ON CALCULATOR (NAAM OP REKENMACHINE): selecteer de
achtergrondafbeelding (dit zou de standaardnaam moeten zijn, maar u kunt de
naam van de achtergrondafbeelding veranderen met dit menu).

Opmerking: schermvastleggingen en geconverteerde beeldbestanden worden als
Pic Vars (afbeeldingsvariabelen) verzonden naar zwart-wit-rekenmachines.

De werkruimte Screen Capture gebruiken 9



10 De werkruimte Screen Capture gebruiken

• GRAPH AREA ONLY (ALLEEN GRAFIEKGEBIED): Selecteer in het rechterpaneel of u
alleen het grafiekgebied wilt verzenden of het hele scherm. Als u een
schermvastlegging terugzendt naar een rekenmachine, kunt u het best alleen het
grafiekgebied verzenden.

Een afbeelding bijsnijden

Een schermvastlegging van het grafiekgebied bevat het volledige scherm van de
TI-84 Plus CE, de statusbalk, de rand van de grafiek en het grafiekgebied.

Met TI Connect™ CE-software kunt u de afbeelding bijsnijden tot het de afmeting
heeft van Graph Area Only (Alleen grafiekgebied) om een Background Image Var
(achtergrondafbeeldingsvariabele) te creëren. U kunt een scherm bijsnijden naar
Graph Area only in het dialoogvenster Send to Calculators (Verzenden naar
rekenmachines).

• DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u de afbeelding
naar alle aangesloten rekenmachines wilt verzenden, of alleen naar geselecteerde
rekenmachines (in een keuzelijst).

Bestanden verzenden naar meerdere rekenmachines

1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het
dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt selecteren.

3. Klik op Send (Verzenden).

Vastgelegde schermen verslepen naar computertoepassingen
Met de werkruimte Screen Capture kunt u vastgelegde schermen verslepen naar tal
van computertoepassingen en ze daarin neerzetten. Met deze functie kunt u
rekenmachineschermen gebruiken in uw documenten.

Schermen verslepen en neerzetten in computertoepassingen

1. Open het scherm of leg een scherm vast.

2. Sleep het scherm naar een geopende computersoftwaretoepassing voor
documenten of presentaties en zet het daar neer.

Opmerking: U kunt ook Bewerken> Kopiëren gebruiken> Plakken in een geopend
document of presentator toepassing op uw computer.



De werkruimte Calculator Explorer gebruiken
Met de werkruimte Calculator Explorer kunt u inhoud op uw rekenmachine beheren.

De werkruimte Calculator Explorer gebruiken 11



12 De werkruimte Calculator Explorer gebruiken

Delen van de Calculator Explorer Main Workspace
Menubalk - Gebruik deze menu's om bestanden en afbeeldingen te beheren,
informatie over de rekenmachine te bekijken en om hulp te krijgen.

Opmerking: u kunt de meeste acties in deze menu's uitvoeren door items vanuit het
Inhoudspaneel te verslepen en neer te zetten.

Werkbalk - Klik op deze pictogrammen om bestanden toe te voegen, over te zenden of
te wissen van uw rekenmachine.

Inhoud toevoegen vanaf uw computer.

Geselecteerde inhoud verzenden naar uw computer.

Geselecteerde inhoud verzenden naar een andere aangesloten rekenmachine.

Het geselecteerde bestand verwijderen.

De weergave van de inhoud van een aangesloten rekenmachine vernieuwen.



Inhoudspaneel - Selecteer bestanden die u wilt beheren vanaf dit paneel.

Een aangesloten rekenmachine selecteren
Met de TI Connect™ CE-software kunt u meerdere rekenmachines tegelijk aansluiten.
Klik op de rekenmachine waarmee u wilt werken om deze te selecteren. De
geselecteerde rekenmachine wordt de standaardrekenmachine voor alle acties van de
TI Connect™ CE-software.

Voordat u begint

Sluit de rekenmachine aan op de computer en zorg ervoor dat verschijnt in de
Calculator List Panel.

Rekenmachinebestanden naar de computer kopiëren
U kunt de meeste gegevens, bestanden en programma's van uw rekenmachine naar
uw computer kopiëren als back-up van inhoud, om naar anderen te verzenden of om
rekenmachinegeheugen vrij te maken.

Een bestand van de rekenmachine naar de computer kopiëren

1. Klik op de naam van het bestand om het te selecteren.

2. Versleep en zet het bestand neer in een map op uw computer of op uw
bureaublad.

Om een bestand van de rekenmachine om de computer te kopiëren als een content
back-up

1. Selecteer bewerken

2. Selecteer alles

De werkruimte Calculator Explorer gebruiken 13
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3. Sleep het bestand naar een map op uw computer of op uw bureaublad.

Let op: Er is geen automatische back-upfunctie hier.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Een bestand van de computer naar de rekenmachine kopiëren

1. Navigeer naar het gewenste bestand op uw computer.

2. Sleep het bestand naar het paneel Lijst met rekenmachines en zet de muis boven
de gewenste rekenmachine.

3. Laat de muisknop los als u ziet.
4. Selecteer een bestandsnaam in het vervolgmenu. Dit wordt de naam van het

bestand op uw rekenmachine.

5. Klik op Send (Verzenden).

Bestanden verzenden naar aangesloten rekenmachines
U kunt bestanden verzenden naar rekenmachines die aangesloten zijn op de TI
Connect™ CE-software.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Bestanden naar aangesloten rekenmachines verzenden

1. Klik op het bestand (s) in Content Panel om deze te selecteren.

2. Klik op .



• DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u het bestand
naar alle aangesloten rekenmachines wilt verzenden, of alleen naar geselecteerde
rekenmachines (in een keuzelijst).

Bestanden naar geselecteerde rekenmachines verzenden

1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het
dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt selecteren.

3. Klik op Send (Verzenden).

Achtergrondafbeeldingen converteren en verzenden
De TI-84 Plus CE kan achtergrondafbeeldingen en Pic Vars weergeven. Deze variabelen
wordt weergegeven in het grafiekgebied.

Opmerking: alle informatie over achtergrondafbeeldingen geldt ook voor de TI-84 Plus C
Silver Edition en de TI-83 Premium CE.

Werken met achtergrondafbeeldingen

De TI Connect™ CE-software converteert een afbeelding die u verzendt naar een
aangesloten rekenmachine automatisch in een achtergrondafbeeldingsvariabele. Uw
afbeelding kan anders worden weergegeven in het grafiekgebied dan u verwacht,
vanwege de conversie naar de pixelafmetingen 83 x 133.

Opmerking: voor de beste resultaten kunt u uw afbeelding bewerken, zodat deze in
verhouding is met 83 x 133 pixels, voordat u de conversie naar 83 x 133 pixels
uitvoert.

Tip! Probeer uw afbeelding te converteren zoals hieronder wordt beschreven. Als
de conversie er niet uitziet zoals u had verwacht, pas dan de afbeelding aan aan de
grootte van het grafiekgebied waar Background Image Vars op de CE worden
weergegeven.

• Maak een schermafdruk van het grafiekscherm op een schaal van 100% met de
optie Screen Capture Workspace. Deze schermafdruk kan worden gemaakt in
de modus Full of in Graph-Table. U gebruikt deze afdruk om uw afbeelding te
verkleinen zodat die past bij het gebied van de grafiek.

• Gebruik uw favoriete presentatie-software en geef de schermafdruk en uw
afbeelding weer.

• Trek aan uw afbeelding om deze kleiner en in verhouding tot het gebied van de
grafiek te maken..

• Gebruik de 'snipping tool' om de nieuwe kleinere afbeelding te 'knippen'. Sla
deze afbeelding op uw computer op.

• Gebruik deze kleinere, proportionele afbeelding om te converteren naar een
Image Var, door onderstaande stappen te volgen.

Onthoud! Bewaar uw originele afbeeldingsbestand door een andere bestandsnaam
voor uw kleinere afbeelding te gebruiken.

De conversie naar de achtergrondafbeeldingsvariabele gebruikt 16-bits kleur.

De werkruimte Calculator Explorer gebruiken 15
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U kunt ook een achtergrondafbeeldingsvariabele uploaden naar de TI-84 Plus CE-
emulatorweergave in de TI-SmartView™ CE-software..

Op de TI-84 Plus CE wordt een achtergrondafbeeldingsvariabele alleen als achtergrond
in het grafiekgebied weergegeven. Een achtergrondafbeelding wordt geschaald
weergegeven bij de MODE-scherminstellingen Full (Volledig), Horizontal (Horizontaal)
en Graph-Table (Grafiek-Tabel). Hierdoor blijft eventuele wiskundige modellering die
uitgevoerd is op een achtergrond, bewaard. U kunt een achtergrondafbeelding niet
bewerken terwijl u aan het werken bent op de TI-84 Plus CE. Achtergrondafbeeldingen
wordt uitgevoerd vanaf en opgeslagen in het Archiefgeheugen.



Een achtergrondafbeelding verzenden naar een aangesloten
rekenmachine
U kunt een achtergrondafbeelding verzenden en deze weergegeven in het
grafiekgebied van de TI-84 Plus CE.

Opmerking: Alle informatie op achtergrondafbeeldingen geldt ook voor de TI-84 Plus
CE-T, TI-84 Plus C Silver Edition en de TI-83 Premium CE.

1. Open de TI Connect™ CE-software.

2. Kies de werkruimte Calculator Explorer.

3. Sluit de TI-84 Plus CE op de computer aan met de kabel.

4. Zet de TI-84 Plus CE aan.

5. Kies de afbeelding die u wilt converteren.

6. Sleep het plaatje naar het paneel Lijst met rekenmachines en zet de muis boven de
gewenste rekenmachine.

7. Laat de muisknop los als u ziet.
8. Selecteer een Image# naam uit het vervolgmenu (Image0 - Image9). Dit wordt de

naam van de afbeelding op de TI-84 Plus CE.

Opmerking: de naam van het Image#-bestand die u kiest wordt de naam van de
afbeelding op uw rekenmachine. Onthoud de naam van Image# (of maakt deze
onderdeel van de bestandsnaam op uw computer) om deze te kunnen herkennen
wanneer u dit bestand wilt verzenden of delen.

WAARSCHUWING: Voorgeladen afbeeldingen zijn opgeslagen in Image1 - Image5.
Gebruik een ander Image# om te voorkomen dat u de voorgeladen afbeeldingen
overschrijft.

9. Klik op Send (Verzenden).

Opmerking:Geef het computerbestand een andere naam, zodat u uw Image Var later
kunt herkennen (brug, fontein enz.). De interne rekenmachinevariabelenaam Image#
wordt niet gewijzigd.

De werkruimte Calculator Explorer gebruiken 17
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Opmerking: Om de achtergrondafbeelding op te slaan op uw computer, sleept u het
Image# van de Calculator Explorer naar uw bureaublad of naar de map waarin u het
wilt opslaan.

• Om uw nieuwe achtergrondafbeelding weer te geven in het grafiekgebied van de
TI-84 Plus CE drukt u opy., verandert u de instelling Background
(Achtergrond) naar het Image# dat u zojuist naar de rekenmachine heeft verzonden
(bijvoorbeeld: Image5), en drukt u ops.

Opmerking: Vanaf het grafiekscherm op de rekenmachine kunt u de achtergrond
ook veranderen met het interactieve commando [draw]; BACKGROUND;
1:BackgroundOn.

Gegevensimport
Met de functie Data Import (Gegevensimport) kunt u spreadsheetgegevens die
opgeslagen zijn als cvs-gegevensbestanden converteren en verzenden naar de
rekenmachine als rekenmachinelijst(en) of een matrixbestand.

U krijgt toegang tot de functie Data Import vanuit de werkruimte Calculator Explorer.

Belangrijkste punten:

• Creëer (of download) een spreadsheet met gegevens.

• Voordat u importeert, moet u de gegevens in uw spreadsheetsoftware bewerken
tot een door de rekenmachine toegestane numerieke opmaak (hieronder
gespecificeerd) voor de import naar een rekenmachinebestand.

Over de spreadsheet

• Er wordt slechts één spreadsheet die is opgeslagen als een CSV (Comma
Delimited) (*.csv)-bestand tegelijk geïmporteerd via de werkruimte Calculator
Explorer.

• Het spreadsheet (csv)-bestand kan naar de Calculator Explorer gesleept worden of
geïmporteerd worden via het menu Actions > Import Data (.csv) to Lists/Matrix...

• Maximaal 6 rekenmachinelijsten of 1 matrix uit de spreadsheet-gegevens worden
naar de aangesloten rekenmachine verzonden.

Regels voor het klaarmaken van de spreadsheet voor import:

• Alle cellen moeten gegevens bevatten, die op de rekenmachine ervaren worden als
reële getallen, en geen tekst.

- Complexe getallen worden niet ondersteund bij gegevensimport.

• De gegevens moeten startn in cel A1

• Importeren van lijst(en): als u rekenmachinelijsten wilt importeren:



- alleen de zes spreadsheet-kolommen A-F worden geïmporteerd
- Kolommen kunnen maximaal 999 cellen bevatten.
- De eerste lege cel in een kolom wordt geïnterpreteerd als het einde van de

gegevens voor de import van die lijst

• Importeren van een matrix: als u een rekenmachinematrix wilt importeren:

- Er kan slechts één matrix geïmporteerd worden uit een spreadsheet-bestand.

De werkruimte Calculator Explorer gebruiken 19
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- Er kunnen maximaal 400 cellen geïmporteerd worden. (Voorbeeld: rij x kolom:
10 x 5 = 50 cellen van de rijen 1-10, kolommen A-E.)

- De afmetingen van de matrix in de vorm (rij x kolom) worden gevraagd tijdens
het importeren in Calculator Explorer.

- Elke lege cel binnen de gespecificeerde matrix wordt geïnterpreteerd als 0.

• Laat geen gegevens in de spreadsheet vallen buiten de toegestane afmetingen
voor lijst(en) of matrices, zoals hierboven beschreven. Anders is het bestand
ongeldig als u de gegevens probeert de importeren naar Calculator Explorer.

Rekenmachinelijst(en) of matrixbestanden opslaan

• Om rekenmachinebestanden die gecreëerd zijn op de computer na het importeren
of verzenden naar de rekenmachine op te slaan, sleept u de lijst(en) of het
matrixbestand van de Calculator Explorer naar de gewenste locatie op de
computer.

Rekenmachinebestanden wissen
U kunt gegevens, bestanden en programma's wissen van uw rekenmachine.

Bestanden wissen van de rekenmachine.

1. Klik op het bestand in de Content Panel die u wilt verwijderen.

2. Druk op .

Quit Onderzoekmodus instelling op aangesloten CE rekenmachines
Sluit de onderzoeksmodus instelling op uw CE door CE calculator(s) aan op de
computer en selecteer

• Acties > Toets-modus afsluiten op aangesloten CE rekenmachines in TI CONNECT™
CE.

Onthoud: Gebruik de meest recente CE-bundel op education.ti.com/84ceupdate om
ervoor te zorgen dat uw CE de meest recente en geschikte rekenmachinebestanden
voor uw TI-84 Plus CE heeft.

https://education.ti.com/84ceupdate


De werkruimte Program Editor gebruiken
De werkruimte Program Editor stelt u in staat om te werken met TI basisprogramma's.

De werkruimte Program Editor gebruiken 21



22 De werkruimte Program Editor gebruiken

Onderdelen van de werkruimte Programma-editor

Menubalk - Gebruik deze menu's om bestanden en programma's te beheren
en hulp te krijgen.

Opmerking: in de werkruimte Programma-editor kunt u alleen
programma's naar het Inhoudspaneel slepen en ze daar neerzetten.

Werkbalk - Klik op deze pictogrammen om een nieuw programma te maken,
een programma te openen, een programma op te slaan op de computer, een
programma te verzenden naar aangesloten rekenmachine(s), een bewerking
ongedaan te maken of opnieuw uit te voeren en de lettergrootte te veranderen
met een schuifknop.

Nieuw programma maken.

Programma openen.

Programma opslaan op computer.



Programma verzenden naar aangesloten rekenmachine(s).

Een bewerking ongedaan maken of opnieuw uitvoeren.

Schuifknop Lettergrootte gebruiken om tekst groter of kleiner te
maken in:
• Cataloguspaneel
• Programma-editor

Inhoudspaneel - Gebruik dit paneel om programma's te creëren, te bekijken
en te bewerken.

Cataloguspaneel - Gebruik dit paneel om uw rekenmachinetype te selecteren
en vervolgens uit lijsten in de catalogus te kiezen (op categorie) om
programma's te creëren.
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Syntax-referentiepaneel - Gebruik dit paneel om de juiste syntax van elk
commando te bekijken, samen met de vereiste en optionele argumenten.

Een nieuw programma maken
Als er geen programma's geopend zijn, dan geeft het Inhoudspaneel alleen de
pictogrammen New Program (Nieuw programma) en Open Porgram (Programma
openen) weer.

Een nieuw programma maken

▶ Klik op het pictogram New Program (Nieuw
programma).

Een bestaand programma openen

1. Klik op het pictogram Open Program
(Programma openen).

2. Navigeer naar de juiste map.



3. Klik op Open (Openen).

Een Var-naam bewerken
Namen van nieuwe programma's zien er als volgt uit: PROG##. De nummers lopen op,
bv.: PROG01, PROG02.

De naam van een programma veranderen

▶ Klik in het vakje Var Name en typ een nieuwe naam van maximaal 8 letters of
cijfers (het eerste teken mag geen cijfer zijn).

Uw programma beveiligen
Met de TI Connect™ CE-software kunt u uw programma beschermen tegen bewerking
nadat het programma naar een aangesloten rekenmachine is verzonden.

Uw programma beveiligen

▶ Klik op het selectievakje naast het slotje.

Een programma opslaan op uw computer
Het sterretje aan het begin van de naam van een programma geeft aan dat het
programma niet is opgeslagen.

Een programma opslaan

1. Klik op .
2. Navigeer naar de juiste map.

3. Klik op Opslaan.

Een programma sluiten
Een programma sluiten

▶ Klik op de x naast de naam van het programma.
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Het Cataloguspaneel gebruiken
Het Cataloguspaneel bevat een lijst met rekenmachinecommando's, functies,
variabelen en symbolen die u kunt gebruiken om programma's te maken.

Een Catalogus-niveau uitvouwen of samenvouwen

▶ Klik op het driehoekje naast elk Catalogus-onderdeel.

Een Catalogus-onderdeel in het Inhoudspaneel plaatsen

▶ Sleep het Catalogus-onderdeel naar het Inhoudspaneel en zet het daar neer.
Hierdoor wordt de cursor in de commandoregel van de Program Editor geplaatst
nadat het is neergezet.

-OF-



▶ Dubbelklik op het Catalogus-onderdeel. Hierdoor wordt het onderdeel in de
Program Editor geplakt; de focus blijft in het Cataloguspaneel, zodat u nog een
onderdeel kunt selecteren. Klik aan het eind van de commandoregel om door te
gaan met typen in de editor.

Syntax-fouten voorkomen:

Gebruik de catalogus met commando's en symbolen om deze in de editor te plakken
om syntax-fouten, als gevolg van onjuist gebruik van hoofdletters en kleine letters in
commando's, te voorkomen.

Voorbeeld:

Heeft u Eval( of eval( ingetypt?

Heeft u sin( of Sin( ingetypt?

De
cataloguslijst
plakt de juiste
opmaak met
hoofdletters,
kleine letters
en spaties.
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Syntax-fouten door extra spaties

Een programma uitvoeren op een rekenmachine

Extra spaties kunnen een syntax-fout veroorzaken bij het uitvoeren van een programma
op de rekenmachine.

Waar zijn de extra spaties?
U kunt extra spaties in uw programma
zien met de TI Connect™ CE Program
Editor, door het gehele programma te
selecteren. Extra spaties aan het eind
van commandoregels moeten
verwijderd worden voordat het
programma naar de rekenmachine
wordt verzonden.

Wanneer het programma op de rekenmachine wordt uitgevoerd en er extra spaties
zijn, dan wordt door Goto te selecteren op het syntax-foutenscherm de cursor op de
programmaregel gezet waar de fout is opgetreden. Controleer de regel op de juiste
syntax en extra spaties aan het eind van de commandoregel.

• Ga met de cursor naar het eind van die commandoregel.

• Verwijder extra spaties zorgvuldig.



Opmerking: op de rekenmachine is er geen functie Ongedaan maken.

Wanneer worden commando's rekenmachinecommando's (tokens)?

De commando's worden pas rekenmachinecommando's (tokens) als het programma
naar de rekenmachine is verzonden.

Als er een fout is wanneer uw programma naar de rekenmachine wordt verzonden of
op de rekenmachine wordt uitgevoerd, controleer dan of elk commando in de
programmabewerkingsmodus van de rekenmachine ook echt een commando-token is.

Hoe weet je dat?

Wanneer een commando een token op de rekenmachine is, dan staat de cursor op het
eerste teken en springt vervolgens over het commando heen als een token. Als de
cursor letter voor letter door een commando beweegt, dan is dat commando niet
omgezet. Verwijder en plak het commando van de rekenmachine.

Geheugensteuntje: wanneer een programma rechtstreeks op de rekenmachine wordt
ingevoerd, dan wordt het commando of de functie in zijn geheel als token geplakt.

Waarschuwing: Sommige rekenmachinecommando's, zoals LINKS, MIDDEN, RECHTS,
BREUK, zijn woorden die u misschien wilt gebruiken in een string. Als een woord dat u
gebruikt in een string hetzelfde is als een rekenmachinecommando, dan wordt uw
woord een rekenmachine-token en kan dit fouten veroorzaken in uw programma.
Gebruik geen woorden of delen van woorden die hetzelfde zijn als een TI-Basic
commando om onbedoelde token-vorming van een commando te voorkomen.

Waarschuwing: de taalinstelling van TI Connect™ CE bepaalt hoe de tekst
geïnterpreteerd wordt als een commando-token voor de rekenmachine. Het openen
van programma's en het terugzenden naar de rekenmachine met TI Connect™ CE in
verschillende talen kan resulteren in:

• ongewenste commando-tokens en/of

• syntax-fouten
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Het Syntax-referentiepaneel gebruiken
Het Syntax-referentiepaneel geeft de syntax van elk Catalogus-onderdeel weer, met de
vereiste en optionele argumenten.

HUB -menu voor TI-Innovator™ en TI-Innovator™ Rover
De Programma-editor ondersteunt het TI-Innovator™ HUB-menu voor TI-Innovator™- en
TI-Innovator™ Rover-commando's. Het HUB-menu staat in het menu Programma's in
de catalogus-boomstructuur. De toevoeging van het HUB-menu aan de TI Connect™ CE
programma-editor is dezelfde HUB-menu-ervaring als wanneer de Hub App op de CE-
rekenmachine geladen is. Gebruik altijd de nieuwste versies van het CE OS en de CE
Hub App.

Opmerking: Update uw CE met TI83CE-bundel v5.4.0 op education.ti.com/84ceupdate.
De update bevat de Hub App v5.4.0. De TI Connect™ CE v.4.0 Program Editor beschikt
momenteel niet over de Hub App v5.4.0.-update. Bepaalde invoer in de Hub App v5.4.0
wordt daardoor niet in de menu's van de TI Connect™ CE v5.4.0 weergegeven, maar
kan wel worden ingevoerd voor gebruik .

Zie ook:

Het Cataloguspaneel
gebruiken

Een programma verzenden
naar een rekenmachine

https://education.ti.com/84ceupdate


Een programma verzenden naar een rekenmachine
U kunt een programma verzenden naar een aangesloten rekenmachine.

Een programma verzenden naar een aangesloten rekenmachine

1. Sla het programma op, als u dit nog niet gedaan heeft.

2. Klik op .
• FILE NAME (BESTANDSNAAM): Deze kan anders zijn dan de NAME ON

CALCULATOR (NAAM OP REKENMACHINE), afhankelijk van welke naam u het
programma heeft gegeven op uw computer.

• NAME ON CALCULATOR (NAAM OP REKENMACHINE): selecteer de naam van het
programma (dit zou de standaardnaam moeten zijn, maar u kunt de naam van het
programma veranderen door op Custom (Aangepast) te klikken.

• LOCATION (LOCATIE): Kies of u het programma wilt opslaan in het RAM of in het
archief van de rekenmachine.

• DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u het
programma naar alle aangesloten rekenmachines wilt verzenden, of alleen naar
geselecteerde rekenmachines (in een keuzelijst).

Programma's verzenden naar meerdere rekenmachines

1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het
dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt selecteren.

3. Klik op Send (Verzenden).

Taalinstellingen

Als u een TI-Basic programma in een andere taal wilt ontwikkelen dan in de ingestelde
taal van het besturingssysteem van uw computer, dan kunt u TI Connect™ CE opnieuw
starten in een andere taal.

1. Selecteer File > Change Language (Bestand > Taal wijzigen).

2. Selecteer de taalverandering na het opnieuw starten van de toepassing.

De werkruimte Program Editor gebruiken 31



32 De werkruimte Program Editor gebruiken

• QUIT LATER (LATER AFSLUITEN) - Bewaart de geselecteerde taal; TI Connect™ CE
start in deze geselecteerde taal de volgende keer dat TI Connect™ CE wordt
gestart.

• QUIT NOW (Nu STOPPEN) - Sluit de software app. TI Connect ™ CE zal lanceren in
deze geselecteerde taal de volgende keer dat TI Connect ™ CE wordt gelanceerd.

• CANCEL (ANNULEREN) - De taal wordt niet gewijzigd. De taal van het
besturingssysteem van de computer is de standaardtaal.



Uw rekenmachine onderhouden
Het besturingssysteem van uw rekenmachine updaten
Met de TI Connect™ CE-software kunt u besturingssystemen voor grafische
rekenmachines downloaden.

Voordat u begint

• Maak een back-up van uw rekenmachinebestanden (RAM, Archief en Apps).

• Zorg ervoor dat uw rekenmachine aanstaat en goed is aangesloten op de
computer.

• Als er meerdere rekenmachines aangesloten met een USB-computerkabels, kan OS
transfers plaatsvinden op specifieke rekenmachines.

Dit kan door het selecteren van de specifieke rekenmachines in het dialoogvenster
verzenden.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Besturingssystemen van grafische rekenmachines updaten

1. Klik op Actions > Send OS (Acties > OS verzenden).

2. Navigeer naar het juiste OS-bestand voor uw model rekenmachine dat opgeslagen
is op uw computer.

3. Klik op Open (Openen).

De Send OS dialoog wordt geopend.
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4. U kunt kiezen uit Bestemming Rekenmachines:

5. Druk op Verzenden .

TI CE Bundle-bestand – gebruik één computerbestand om uw CE-
rekenmachine bij te werken!
Werk uw aangesloten CE-rekenmachine(s) in één stap bij met TI Connect™ CE en de
nieuwe TI CE Bundle die u gedownload heeft van education.ti.com/84ceupdate.
Download altijd de nieuwste TI CE Bundle op education.ti.com/84ceupdate.

Sluit uw CE-rekenmachine(s) aan op TI Connect™ CE. Sleep de gewenste TI CE Bundle
naar de Calculator Explorer.

• TI-84 Plus CE/CE-T: TI84CEBundle-x.x.x.xxxx.b84

https://education.ti.com/84ceupdate
https://education.ti.com/84ceupdate


TI Connect™ CE werkt uw CE OS bij en ook CE-apps die bijgewerkt moeten worden of
die ontbreken op uw rekenmachine(s) en laadt tevens de 5 voorgeladen Image Vars
naar Image1 – Image5. Het proces kan niet worden gestopt, dus zorg ervoor dat u uw
favoriete rekenmachinebestanden opslaat (wegsleept) met behulp van de TI Connect™
CE Calculator Explorer. U kunt uw favoriete rekenmachinebestanden vervolgens
terugslepen naar uw rekenmachine, nadat het nieuwe TI CE Bundle-proces voltooid is.

Sleep de gewenste CE Bundle naar de Calculator Explorer. Wacht tot het volledige
proces voltooid is. Trek de kabel niet los tijdens het verzenden van gegevens. De CE-
rekenmachine kan opnieuw opstarten voor het overzenden van Image Vars en Apps. De
CE-rekenmachine kan een defragmentatie uitvoeren (het geheugen opnieuw ordenen)
op enig moment tijdens het proces. Tijdens het overzenden worden er berichten
weergegeven in het TI Connect CE-venster.

Opmerking: Haal het TI CE Bundle-bestand niet door elkaar met het CE OS- en CE App-
bestand dat nog steeds apart gedownload kan worden op education.ti.com. De TI CE
Bundle bevat alle nieuwste bestanden die u moet bijwerken of herstellen op uw CE-
rekenmachine(s) alsof u uw rekenmachine net gekocht hebt, en biedt een snelle
manier om uw serie CE-rekenmachine(s) in de klas bij te werken.

Belangrijk: Als het bericht "Waiting..." (Wachten...) op het scherm van de CE-
rekenmachine verschijnt, is de rekenmachine het OS kwijtgeraakt. Dit kan gebeuren als
er een kabel is losgetrokken uit de rekenmachine of computer tijdens een het
overzenden van bestanden. Als de kabel wel aangesloten is, koppel hem dan los en
sluit hem weer aan op de computer. Sleep de gewenste CE Bundle naar de Calculator
Explorer.

Onthoud: Wacht tot het volledige proces voltooid is. Trek de kabel niet los tijdens het
verzenden van gegevens. De CE-rekenmachine kan opnieuw opstarten voor het
overzenden van Image Vars en Apps. De CE-rekenmachine kan een defragmentatie
uitvoeren (het geheugen opnieuw ordenen) op enig moment tijdens het proces. Tijdens
het overzenden worden er berichten weergegeven in het TI Connect CE-venster.

U kunt dit proces herhalen; dan verzendt de CE Bundle de bestanden opnieuw. Trek de
kabel niet los tijdens het verzenden van gegevens.

Zie ook:

Het besturingssysteem van uw rekenmachine updaten

Bestanden verzenden naar aangesloten rekenmachines

Informatie over de rekenmachine krijgen
Met TI Connect™ CE-software kunt u informatie over uw rekenmachinetype, product-ID,
OS-versie, RAM, archief, taal, ROM-versie en hardwareversie krijgen.

Opmerking: Calculator informatie is alleen beschikbaar vanaf de Calculator Explorer
Work Space.

Informatie over de rekenmachine bekijken

▶ Klik op View > Calculator Information (Bekijken > Rekenmachine-informatie).
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Compatibiliteit met grafische rekenmachines
Raadpleeg de TI-84 Plus CE Getting Started Guide (introductiehandleiding voor
compatibiliteit met grafische rekenmachines.

Toepassingen, besturingssystemen en sommige gegevensbestanden met ondersteunde
numerieke types niet delen tussen modellen.

TI-Basic programma's eventueel moeten worden aangepast om een correcte weergave
van de hogere resolutie kleurenscherm modellen.



Algemene informatie
Online Help
education.ti.com/eguide

Kies uw land voor meer productinformatie.

Neem contact op met TI ondersteuning
education.ti.com/ti-cares

Kies uw land voor technische en andere ondersteuning.

Informatie over service en garantie
education.ti.com/warranty

Selecteer uw land voor informatie over de lengte en voorwaarden van de garantie of
over de productservice.

Beperkte garantie. Deze garantie heeft geen invloed op uw wettelijke rechten.

Updates
seducation.ti.com/84ceupdate
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